HydroGeo Analyst: A Data Management Solution to Ground Water and Environmental Projects
reviewed by Yongqiang Qi¹ and Vincent Post²

Introduction

Hydrogeologic data often come from a variety of sources and in different formats. A software platform to organize, access, edit, and report all these data is a prerequisite for effective management of ground water and environmental projects. Data management software for such projects needs to be (1) comprehensive—allowing the storage of multiple layers of information such as lithological data, geophysical data, water levels, and water quality data; (2) versatile—allowing data in a variety of formats; and (3) intuitive—having a simple and easy-to-use interface. HydroGeo Analyst, developed by Waterloo Hydrogeologic Inc. (WHI), is intended to be such an environmental data management system. It is designed to handle routine tasks such as data interpretation, statistical analysis, GIS mapping, data charting, and visualization within a single software platform to minimize the time and effort involved in the data communication and migration. HydroGeo Analyst operates as a desktop application based on Microsoft SQL Server technology, which enables Internet-based server-client data communication. More information on HydroGeo Analyst can be found at the vendor's Web site at http://water.slb.com.

How We Tested

The version of HydroGeo Analyst (referred to as HGA hereafter) reviewed for this column is Version 4.0.0.8 for a 30-d trial. One reviewer tested it on a Dell desktop with a 2.60 GHz Intel Pentium 4 CPU and 512 MB RAM running Windows XP SP2. The other reviewer used a generic PC with a 3.06 GHz Intel Celeron D CPU and 512 MB RAM running Windows XP Professional Edition SP2.

¹Corresponding author: Department of Geological Sciences, University of Alabama, Tuscaloosa, AL 35487; yongqiang.qi@ua.edu, yongqiang_qi@pku.edu.cn

The software setup file was downloaded from the WHI ftp site. The file size was 185 MB. Before the setup process can be started, both Microsoft.NET Framework 2.0 (22 MB) and Microsoft Core XML Services (1.5 MB) needed to be installed on the computers. The download from the WHI ftp server was quite slow and the installation process took about 1 h to complete.

HGA itself occupies about 300 MB hard drive space. The space requirements of the compulsory Microsoft packages are unclear. No interference with preexisting software packages installed on the computers was noted by either reviewer. On one occasion during the test process, the “Map Manager” module of the software crashed when it was closed (access violation). One reviewer noticed that when the software was started for the first time, it took about 1 min for the program screen to display, giving the impression that the program had crashed. Subsequent startups were faster, requiring about 15 s. In addition, a number of installation attempts were performed on a separate Dell Latitude laptop without success. These unfinished installation instances created multiple temporary files on the primary hard drive that had to be manually removed.

The software installation comes with a tutorial containing a suite of borehole and analytical data. These data are managed via Microsoft SQL server technology, which supports client-server data communication. For test purposes, the data server and client were installed on the same computer. The database connection between the client and the server sides was successfully established upon the opening of the tutorial project. The data communication throughout the test session appears to be stable and reliable. The software was tested by (1) following the “Getting started” section in the HGA help file and (2) experimenting with the example database that is distributed with the software.

What We Found

Documentation

A comprehensive help file was distributed with the software. No printed or digital copy of the user’s manual
was available. Nevertheless, the help file alone provided enough information to get started on a beginner’s level within 1 h. Additionally, an HTML file provides a summary of new features, recent changes, and known issues. A list of frequently asked questions is a helpful resource and available on the WHI Web site.

**User Interface**

After the application has started, an interface, which is similar to any Windows-based application, appears with a pull-down menu structure and a button toolbar. A project is opened through the “Project→Open” pull-down menu. Once a project is opened, the main control panel is the “Project Browser” on the left side of the main screen. From there, all the components in a project can be accessed. These include the observation point data, maps, reports, plots, and borehole logs. A variety of data can be stored, including lithological and hydrogeological data, well construction data, soil analyses, water level and chemistry data, geophysical logs, and well history. The database can be customized so that any data that do not fit in the predefined templates can be incorporated into custom-defined tables.

Figure 1 is a snapshot of the HGA program window showing its two-dimensional (2D) mapping module.

If a particular data type is selected from the Project Browser, for example, “Geologic description,” a table opens on the right-hand side of the screen. The layout of the table depends on the type of data that is selected. The data can be edited directly in the tables.

The HGA software interfaces with other WHI software products such as Aquifer Test and AquaChem. This enables more detailed analysis of hydraulic properties and water chemistry. Since these tools were not available on the test systems, this functionality was not examined.

**Data Management**

For the purpose of starting a new project or providing additional data to an existing project, HGA provides two ways of entering data to the project: (1) manually in the grids and (2) importing from other sources using the Data Transfer System (DTS). To facilitate manual data entry, there are two data views available: station list view, which tabulates all available records, and station data view, which tabulates only the fields of the current record. The data viewing window is intuitive to those familiar with any other data management software. Routine data management tasks such as record appending, modifying, and deleting can be easily accomplished. The DTS operates through the menu option “Project→Import→Data.” HGA supports static data sources such as Microsoft Access database (*.mdf), tabulated text file (*.csv), Microsoft Excel spreadsheet (*.xls), and Dbase database (*.dbf). It also supports dynamic data acquisition from a remote data manager through a connection query string. The building of the query string is facilitated by the standard Windows wizard, which should be familiar to anybody who has remote database operation experience.

HGA integrates a data security system (the User Access Level Management component) that allows protection for both file-based data (e.g., model inputs and outputs) as well as database data (e.g., data stored in HGA). This component can be accessed by selecting the menu option “Settings→Manage User Access Level.” The user group concept is similar to that used in the Windows system. The structure of HGA’s database is managed by a tool named Template Manager, which can be accessed by selecting the menu option “Settings→Template Manager.” The interfaces of these tools are intuitive and easy to use.

All data records in HGA are saved and referenced to a “station.” A station is a unique real world location at which data collection activities are performed. Most operations in HGA require the selection of one or more stations in the station list tab. Depending on the scope, a project may contain single or multiple station types, each with its own attributes. Typical examples of stations are boreholes, pumping wells, observation/monitoring wells, surface water observation points, and weather stations.

Stations are organized into station groups based on certain criteria such as locations, types, or purpose of the stations. Multiple layers of information can be assigned to a certain station. The information can be added, edited, or retrieved by selecting the “Station Data” item from the navigation panel located to the left of HGA main interface or by selecting the “Station Data” tab from the main data view panel. The “Station Data” tab provides access to all data related to a single station. Once a station is added to the project, detailed information on the station can be inserted, edited, or deleted through this tab.

All data communications within HGA are driven by queries. The system built-in queries such as Station Groups and Station Data are the most common ones. It often becomes necessary for users to customize the queries so that the data can be filtered in a specific way. Queries can be constructed and executed through a module named “Query Builder” located in the menu option “Tools→Query Builder.” This module can help users design the SQL query string according to their needs, even if they have no previous experience with the SQL query language. This module also enables users to edit, delete, or retrieve previously saved queries.

![Figure 1. A screen capture of Hydrogeo Analyst running under Windows XP showing the layout of well locations and concentration measurements on a site map.](image-url)
Mapping

There are three mapping modules in HGA: Map Manager, Cross Section Editor, and 3D Explorer. Map Manager is a horizontal 2D mapping module built on ESRI Map Objects technology. It is packed with GIS mapping features commonly used by the environmental industry. The main purpose of this module is to analyze and to present the spatial orientation of ground water or borehole data. Cross Section Editor is a vertical 2D mapping module designed for presenting geological and hydrogeological information as well as ground water modeling domains. 3D Explorer is a three-dimensional (3D) visualization and animation component for displaying multiple cross sections in the form of fence diagrams. In addition, base maps can be displayed for relating the fence diagrams to surface features.

Map Manager operates graphics in the format of layers. A similar concept is used in almost every contemporary graphic designing tool, such as AutoCAD, CoreDraw, Illustrator, Photoshop, and ArcMap. A map project in HGA may have an unlimited number of layers. These layers may be organized into Layer Groups to help users manage the visibility and draw orders of multiple interrelated layers. Text, raster maps, CAD drawings, shape files, and surface files can be imported to Map Manager, aside from the conventional point/line/polygon layers supported by any GIS system. HGA is capable of generating data annotations (tables or plots) for point layers. These fields are based on points data loaded from Station Groups or Data Queries. Additional conditions may be defined for these data so that rows in the tables that violate the conditions can be highlighted. Map Manager can also define the location of cross section lines. These lines can then be interpreted in the Cross Section Editor.

The Cross Section Editor is designed to interpret geological and hydrogeological data as well as ground water flow model domains. After a cross section line has been drawn in the Map Manager, the borehole data in the vicinity of this line (determined by the buffer value entered for the line) will be loaded into Cross Section Editor to produce a borehole map. This map can be further edited to include geology and hydrogeology information. The vertical boundaries of each geologic/hydrogeologic unit can be defined from surface files (*.grd, *.dem, *.asc, and *.txt). These boundaries can also be added or edited manually by maneuvering the vertices of the created lines and polygons. Map Manager and Cross Section Manager are designed to be in the same daughter window of HGA. Users can easily switch between these two modules by using the tabs located on the right side of the Map Manager interface.

3D Explorer is a 3D visualization and animation tool whose main purpose is to produce fence diagrams using the geographical, geophysical, and geochemical data stored in HGA. The components that can be displayed in HGA include lithology stations, imported surfaces, contaminant isosurfaces or color maps, and base maps. All these components need to be previously created by other modules of HGA and imported into 3D Explorer. Although 3D explorer can modify the rendering options of these components, it cannot edit their actual content. Existing base maps, surfaces, and contaminant concentrations can be directly imported into 3D explorer; lithology stations (cross sections) need to be configured in the Map Manager to be available in the 3D Explorer. After setting the rendering options for the components, the 3D orientation and lighting options can be configured easily. 3D Explorer also supports Microsoft Audio Video Interleaved (AVI) format video output where spatial rotation, temporal plume evolvement, and concentration distribution can be animated individually or simultaneously. Figure 2 shows a typical fence diagram created by the Cross Section Editor.

Reporting

HGA provides a series of useful reporting tools, including Borehole Log Plotter, Plot Designer, and Report Editor. Borehole Log Plotter is a simple tool that can display detailed lithological information for a given borehole. The design of a borehole log is based on the user’s choice of a few optional columns that can be displaced next to each other. Aside from the items one would expect from a conventional borehole log (scale, well construction schematic, lithology description, and depths), other types of columns such as plots and pictures can also be added on request. Plot Designer is a simple graphing tool similar to Microsoft Excel, Grapher, or Origin. It can produce line charts and bar charts using the data stored within HGA. Report Editor finalizes any HGA data or visualization into a report format. Users can customize headers, footers, legends, and page settings in this module. Multiple templates can also be used for each type of final output.

What We Liked

Hydrogeologic data come from multiple sources and in different formats. The DTS in HGA allows the user to import and export data from and to a variety of formats. This feature makes HGA a versatile tool because external data can be added quickly and with ease. HGA is built around Microsoft SQL Server, a well-designed relational database management system widely applied in many
What We Did Not Like

One of the weak points of the software is that the layout of the windows is not always optimal and sometimes windows are not properly displayed. For example, in the DTS, the button to browse for a file to import is hidden unless the window is maximized. Moreover, the input fields in the data tables are relatively small, and text entered in them or identifying headers is often partly hidden and thereby difficult to read. The right-click menu of HGA also leaves something to be desired. For example, if the user right clicks a cross section object in the navigation panel of the HGA main interface, the pop-up menu contains four items: Open, Remove, Refresh, and Refresh All. A few other items could be added to this list, such as New, Modify, Show Vertices, Properties, and View 3D.

Entered data are not stored until they are explicitly “posted” by the user. Although there is probably a good rationale behind this, it would be preferable to see the data stored immediately, as is often the case in comparable database applications. One reviewer (who is based in Europe) noticed that the database templates shipped with the software are exclusively Canadian/American. Given the origin of the product, this is understandable, but there seems to be some room here for internationalization. Perhaps the WHI Web site could allow users to upload templates that could be downloaded by others.

The installation of HGA is not as straightforward as a lot of other professional software products, mostly because it is based on SQL Server technology. SQL Server is a Microsoft product and has deeper than usual involvement with the Windows operation system. Unpredictable problems can occur while the two prerequisite components or HGA itself are being installed. The reviewers would like to see a more straightforward installation procedure and better documentation targeting the potential problems arising during the installation process.

The GIS environment (Map Manager) of HGA is built on ESRI Map Object technology and has only a fraction of the mapping capacities of the ESRI GIS software family. Because of this limitation, the performance of Map Manager is not as professional as the popular GIS platforms. At the current stage, the Map Manager is not likely to replace other GIS software and become the sole platform for project-level mapping.

Overall

The reviewers are pleasantly surprised by this software. The well-designed software clearly was created by those who understand the needs of the ground water and environmental industry. HGA is advertised as a comprehensive, yet easy-to-use environmental data management system. With respect to comprehensiveness, the software certainly fulfills this claim. The ease-of-use claim is largely fulfilled too, although the overwhelming number of options (primarily an excellent feature) is somewhat prohibitive in this sense. Some knowledge about relational databases seems a recommended prerequisite to take full advantage of all the software’s options. Nevertheless, with some previous exposure to data management and graphic design software, the user should be able to master the full range of functionality within a relatively short time.

The software is very well suited for professionals who are dealing with large data sets on a daily basis. The many features as well as flexible input/output of data ensure that the software will be adequate for a great majority of potential applications. Overall, the data management...
functionality outperforms the graphic functionality. The price of $5495 USD (as posed on the WHI Web site) and to a lesser extent the “heaviness” of the application in terms of computer resources, number of features, and required operating skills make the software a somewhat less obvious choice for the “occasional” user. Nevertheless, HGA lives up to its promises and is certainly recommended.

Ranking

The reviewers ranked the software’s capability, reliability, ease of use, and technical support on a scale of 1 (worst) to 5 (best). The following rankings are the average of three sets of scores from both reviewers and the editor:

- Capability: 4.5
- Reliability: 4.0
- Ease of use: 4.3
- Technical support: 4.5 (one instance)

How to Obtain the Software

For software download and pricing information, visit the Web site of Water Hydrogeologic Inc., Schlumberger Water Services: http://www.slb.com/content/services/additional/water/software/hydrogeo_analyst.asp.

Our Mission

The goal of Software Spotlight is to help readers identify well-written, intuitive, and useful software. Independent reviewers from government, industry, and academia try out full working versions of software packages and provide readers with a concise summary of their experiences and opinions regarding the capability, stability, and ease of use of these packages.

Chunmiao Zheng can be reached at the Department of Geological Sciences, University of Alabama, Box 870338, Tuscaloosa, AL 35487; czheng@ua.edu.